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Setup and Registration

Reynolds and Reynolds’ F&l Product Rating and Booking is available for ERA-IGNITE, F& Menus, and the
docuPAD® System The product rating feature gives you the ability to access your providers’ pricing for
service contracts, aftermarket products, and GAP products in real time. The product booking feature gives
you the ability to transmit contract details to providers and receive completed F&l forms in return.

This guide will cover how to register your dealership and your aftermarket providers. It will take you through
the specifications for the rating and booking features so you can customize them to fit your process. This will
also show you how to rate and book your F&l products in a few simple steps.

You will need to have access to Finance and Insurance Specs to perform registration activities. This
guide will outline how to set up security access for this.

3 (SEC - PPD26) - o x Finance and Insurance (Specs) >
Functions File Subscreens Tools Display Reports Print  System Tools Go To VSC Ratlng and Product — Screen

Q¥ HA P ENeDEaFECTEA(R Access

Security Access M Dealer and Product Registration

Applicatiﬂs _ M Pricing Controls

: M Additional Controls
= @ Finance and Insurance (Specs)

@ AddOnduto Integration

@ Bank Defaults - Screen Access To rate and book products you
@ Check SD.ECIfICatIDnS - Screen Access will need the following access:
@ =Contracting - Screen Access

O e F&I/Desking > Actions

I+

@ Insurance Date History - Screen Access
2 P oo bl oot oe oo

PRB: Book/Void Contracts

Degcription Permizzion | Wiew Only Jszer Group PRB: Get pricing
Additional Contrals O |
Dealer and Product Registration O O F&l/Desking > Screen Access
Fricing Controls | O . .
‘ e | TET S ) ] VS(? Rating and Produc?t Display
F&l/Desking - Aftersales — Fields
Legend Ttem Mote L. .
@ - Full Access @- No Access M VSC Orlglnal Ratlng Cost
& - Partial Access (optiona|)
Assign User Group
User ID PPD26 Full Name Denny Hirt Store 27 / Branch 01
F1] Help F2 Fa F4 F& FE
F7 F8 Fa Fid Fi1 F12 Update
» Esc=Return PgUp/Dn=Next Screen Ctrl=More
[ [Record Viewed [SECSSATD  [PPD26 [27/FANDIOL [A62/80069 [OVR [5104
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Step 1: Register your dealership

€ (Desking - 27/01) - Sales and F&l - o x
FIN Fur s fle su ¢ Tools Diply Reports Print (LIl Go To
Rl O [Wl§ soomensm B YT Y PLALE
P itart Deal
Calculator
New Preferences >
Deal Type ustomer Vehicle [Type  [Temp | status
Financial Inst. CASH Work sd RAHAN, HANG CHEVROLET TRUCK SILVERAD... Retail s
Customer # [ @& ERA Job Scheduler BPRINGBORN, MICHAEL S TOYOTA COROLLA 4DR SDN C... Retail s
Stock # [—| P ——— ALLUCL, FRED MAZDA MAZDA3 5-DOOR 50R ... Retail s
Deal Category Er——— e REEN, MATHEW TOYOTA TACOMA TRD OFF R... Retail s
o ERCEDES, KENNETH MERCEDES-BENZ C-CLASS C 3... Retail s
(TRl 3 ERA Mailbox. REEN, MATHEW TOYOTA TACOMA TRD OFF R... Retail s
Ne OOFER, SHELDON CADILLAC CT6 SEDAN 4DR SDN  Retail s
(5 ERA Email Composer
ILLER, BLAR TOYOTA COROLLA LE ECO CV... Retail s
] B SMS Text Messaging EORGE, TIM FORD FOCUS SDR HB TITANIUM Retail s
Deal # [ B} sMs Text History HIEMAN, BROOKE HONDA PILOT EX L 4 DOOR Retail s
Stock # | Language Override RIMKE, JOHN MERCEDES-BENZ GLA45 GLS50... Retail s
Start Date UIDRY, MAURICE CHEVROLET TRUCK TAHOE 4D... Retail s
End Date (| Webgervice Overrides IALLACE, RUSTY K TOYOTA TACOMA 4X4 DBL CB... Retail s
77406 BM3Z8172 ROBB, JOHN A CHEVROLET TRUCK TAHOE 4D... Retail s
Customer tastame [ |
| ] 2222 =2 o =ON v FORD TRUCK F-150 SERIES 4... Retail s
ustomer First Hame = 23001 ACO38817 ABRAMS, NORM MITSUBISHI OUTLANDER SPO... Retail s
Employee Number 23000  CLIFFTOY ABRAMS, NORM TOYOTA CAMRY 4DR Retail s
Employee Name 22375  CLIFFHON ABRAMS, NORM HONDA RIDGELINE 4WD CREW... Retail s
Employee Role N O 22371 FCDO0301 STIPP, BEN DODGE TRUCK GRAND CARAV... Retail s
docwPAD Status | [7] 22354 EM617158 LANHAM, KARA HONDA ACCORD SEDAN 4DR S... Retail s
2 (FIN Specs) - Sales and F&u - O »
Fie TJook Print  System Took Go To
itis il -
DS Utilties - Jt==R Y | 38
Miscellaneous F&I Specifications L3
Maintenance »
Check Spedifications + 5 F&d Specifications eContracting
eContracting » Vendor Setup
T
VSC Rating and Products Dealer and Product Registration h
Life & A&H Insurance Maintenance » Pricing Controls
i i L} Additi °
Insurance Date History Additional Controls Ir . -
Bank Defaults 4 if It Selection
F&I Menu Designer Specifications Life & ARH Insurance Maintenance
— intenan Life Reserve Deviation Rates
F&I Conditional Event Defaults I -
lintenan: ASH Reserve Deviation Rates
ption Life Caps
punting Integration ARH Caps
Forms * Preferences ife Enable/Disabl
Deal Jacket » AS&H Enable/Disabl
elegotiator *+ lcations
N
B2 Addonsuto » plions
[pse Names
Deal Manager Specifications
Credit Bureau Inquiry » E'u,_
L3 (FIM Specs) - Sales and F&I - ] x

creens Tools D

Functions File

olay  Print  System Took Go To

@%IE?ME@IQDIF FOoaBA|VERIOwW 7

Dealer and Product Registration

~Dealer Registration

Dealer Name

Dealer ID# | Registration Date | ‘ ‘

REYNOLDS MOTOR CO.

[ [Register | |

Processing...

L Registration in progress...
Please Wait...

P

FINCVS01 - 1009 X

o Registration was successful.

Dealer Select |

=1

Registered Providers/Product:

Provider/Product

| Registration Date _ Product Type

From the F&I/Desking main screen, click
System Tools > Specs.

From the FIN Specs screen click
Functions > VSC Rating and Products >
Dealer and Product Registration.

B Click Register next to the Dealer Name.
When the system is Anished processing, a
success notiAcation will pop up.

Note: Your Dealer ID# will be assigned
when you register; no manual entry
required.
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Step 2: Register providers and products

3 (N Spec) -Sales and e -7 Use the down arrow next to Dealer
Functions File Tools Print  System Tools Go To S | t t | t d | h CI k
Q¥ HA P EleDEaFooEA|R elect to select dealership name. Clic
Dealer and Product Registration PPD26 A62 03/05/18 09:58:33 RegISter New Product.
Dealer Registration
Dealer Name | Dealer ID# | Registration Date ‘ | ‘
TEST - OPEN ROAD MOTORS 133967 03/22/16 Unregister | Update
ABC MOTORSPORTS 137076 11/09/16 Unregister | Update
TEST - OPEN ROAD MOTORS 2 112078 09/09/13 Unregister | Update
- Provider and Product Registration
Dealer Select |[ABC MOTORSPORTS Register New Product
[T Registered Providers/Product
Provider/Product Registration Date | Product Type
Provider Selection B Click the double arrow on the left
sSelect Providers or Regitrasion to choose products to register from
rovider Provider ID . . . .
'_9 celerated Sarvice Tnter 8 providers with which your dealership has
&2 fadvanced Protection Produ 89 . iati i i
:&9 dvantage Product Pipelin 36 :chessmg'" x : an eXIStIng relatlonShlp'
& 24
‘@ 5 | Product request in progress... B
"a PP) 65 1 Please Wait... B
:&9 ehicle One) g | - F
&2 Mlpha Warranty Services 29 |
&2 american Auto Guardian 34
&2 american Guardian 26
_Qa 37
&2 farmorAll 67
& WSC Warranty 68
Assurance Flus 97
& | Audi Financial Services 101
& AUL 3
| |63 Autnshield 79
Provider Selection ® B The products available for the provider
Select Providers for Registration . . .
oo - will then display. Enter the Provider ID
Provider Provider ID 2
% it A given to you by the provider next to
Continental Warranty 109 . .
@ Crystal Fusion 118 the products you wish to register.
@ csa 52
O Dealer Admin Services = Uncheck the boxes next to the products
& Dealer Maintenance 72 H H
& | Deciers Choice o you do not want to register. Next, click
& | Demo Provider B 35 Register (F1 2)
Product Provider Dealer ID | Product Code | Prefix Override Status o)
|Demo GAP
| Demo Paintless Dent Repair
\Demo Theft Protection
Demo Tire And Wheel . ..
el . > Note: The Provider Dealer ID is issued by
Register (F12) || Cancel your provider. If the provider requires a
@] Dent Wizard 7 product code or prefix override, they will
3 e o supply that to you as well. If you do not
|9 DentPro 121 v know your ID, you will need to contact
your provider or provider agent.
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Provider Selection X

n You will receive a Registration Complete
pop up box; click OK. Then click Close

Select Providers for Registration

Provider Provider ID Lo
@ | Accelerated Service Inter 78 in the bottom right corner of the Provider
&% Advanced Protection Produ 89 .
&  Advantage Product Pipelin 36 SeleCt|On screen.
& | AFAS 24
@ Allstate 6
& Ally (APP) 65
& Ally (Vehicle One) _F\No‘/sxw - 1003 : X
& | Alpha Warranty Services
&2 American Auto Guardian L
- | Product Registration is complete.
& American Guardian | * IMPORTANT: Please contact Demo Provider for
&3 | ANICO details on Rating, Booking, Voiding and
@ | Armorall 1 Remittance. You may also contact the
@ AsCw ty - | Reynolds & Reynolds Support Team.
arran
&  Assurance Plus 1
2 | Audi Finandial Services -OK
@ AUL
& | Autoshield 79
&2 | AutoXcel System 85
@ Axiom 92
@ BMwW 64 %

| Close

3 (FIN Specs) - Sales and F&I -

]
x

B Select the Product Type by clicking on
Functions File Tools Print  System Tools Go To

O%# HaAP|EENeDmafa=oEA|® the drop down list next to each product
that was registered. You can select

Dealer and Product Registration PPD26 A62 03/05/18 10:20:33
Dealer Registration Aftermarket, ESC/Ma|ntenance, or GAP
Dealer Name | Dealer ID# | Registration Date | | |
TEST - OFEN ROAD MOTORS 133967 03/22/16 Unregister Update based on your prOCGSSSS
ABC MOTORSPORTS 137076 11/09/16 Unreqgister Update
TEST - OPEN ROAD MOTORS 2 112078 09/09/13 Unregister Update

Provider and Product Registration

Dealer Select |[ABC MOTORSPORTS [*] | Register New Product

Registered Providers/Products

Provider/Product | Registration Date | Product Type |
Demo Paintless Dent Repair 03/05/18 Aftermarket E] Unregister
Demo Theft Protection 03/05/18 Aftermarket E] Unregister
Demo Tire And Wheel 03/05/18 Aftermarket E] Unregister
Demo VSC 03/05/18 ESC/Maintenance E] Unregister
Demo GAP 03/05/18 GAP @ Unregister
Demo Appearance Protection 03/05/18 ~ | Unregister
Aftermarket %
ESC/Maintenance
GAP
Count 6
F1] Help F2l List F3 Fé e F§
F7 Fg Fa F1d il F12 update
> PgUp/Dn=Subscreens
[ [Record Viewed [FINCVS01  [PPD26 [27/FANDI0T [A62/80069 [OVR [5104

IMPORTANT

It is imperative that you contact your provider(s) for important information regarding their speciAc rating,
booking, voiding, and remittance processes after you have successfully completed the registration
process. Some providers require additional steps to be taken in order to properly rate, book, void, and
remit contracts.

You can also contact Reynolds at 800.767.0080 for speciAc details.

Confidential & Proprietary Information of the Reynolds and Reynolds Company © 2019




Step 3: Set Product Integration Controls for pricing and profit information by product

3 (FIN Specs) - Sales and F&
File Tools

Print  System Tools Go To

0DSs Utilities
Miscellaneous E&I Specifications
Maintenance

Check Specifications

eContracting

VSC Rating and Products

Life & A&H Insurance Maintenance
Insurance Date History

Bank Defaults

F&I Menu Designer

=

sl = B A%

PPD26 A62

ealer ID# | Registration Date |
Dealer and Product Registration er
Pricing Controls Ll
k er

Additional Controls

From the FIN Specs screen click
Functions > VSC Rating and Products
> Pricing Controls.

B DeAne markup percentages or amounts by
product type.

Dealer Select Pricing Controls

+ Select the option of setting an overall
default or itemizing per speciAc provider/
product.

+ Itis possible to set certain parameters
such as New/Used, Plan, Months, or
Miles.

— Note: Plan name has to be exactly as
the rating would display

+ Retail Price
- Flat Amt
— Cost vs. List Basis
- Markup based on % or $
- Rounding (ex. Next X.00 or Next X .99)

+ Cost Pack % or $
— Flat Amt
- Pack $ or %

« Surcharge
— Cost vs. List Basis
- Markup based on % or $
— Rounding

+ Display Misc Product Modal

— Display Product Modal only on new,
used, or both (ex. Business Use,
Warranty Remaining)

— Do not display the modal at all by
selecting No

Note: Pricing Control specifications are
set for each Dealer Select and also by
Aftermarket, ESC, Maintenance, and GAP.
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3 (FIN Specs) - Sales and Fa - B From FIN Specs screen, Click Functions >
Functions  File Tools
~ T . . VSC Rating and Products > Additional
Q# HA P EENeDQEaFa=oE A (®
Controls
Additional Controls PPD26 A6201/3
Default Product B Default Product
Dealer Select |[ABC MOTORSPORTS =]
_ + For each dealer select, select the default
R E]| R - product you will see in the Product and
Aftermarket Demo Tire And Wheel [
ESC1 Demo VSC (=] O Rating Request screen for each group.
ESC2 [~ d . .
Maintenance 1 = o » By checking the Automatically Rate box,
Maintenance 2 (-] it will force the pricing to pull within the
] .
S Pemo GAP L) Product and Rating Request screen
["] override Aftermarket Description with Provider Plan Description WIthOUt having tO manua”y CliCk ‘Get
F&I Menus Unbooked Aftermarket Products PriCing’.
[C] override Markup Rules Spot Deliver Status
Save Product Frice to (@) Retail Price Close Deal Status [Error message _[] F&l Menus Controls
S « Override Markup Rules - If this is not
selected, the Menus markup rules are
used. If this is selected, then those
rules are overridden. As an example, if
Menus has a $200 markup limit, but the
rated product is marked up $500, you
will want to override the Menus markup
limit by checking this box.
+ Retail Price is the price before the Menus
discount has been applied (if applicable).
« Sale Price is the price after the Menus
discount has been applied (if applicable).

Then choose Unbooked Aftermarket

Product rules.

Unbooked Aftermarket Products Rules
+ You can set what messages (if any) pop
up when delivering or closing a deal

— No message — Deal will Deliver or
Close without message.

— Warning message — Deal will inform
associate they have unbooked
products, but will allow them to Anish
the deal.

— Error message — Deal will inform

B e oo the associate they have unbooked
O# H«p|ElieDmaPFo=EA[ products, and will not allow them to
et BroducE el Anish the deal.
[ code | Description | vSC Rating Provider [ Tax [ Profit [weowe | Price | 50 Cost | Commiss
; ISIEMEI ZZZEQARQQCEPRDTEU‘DN Demo Appearance Protection %32: %g:zi;j %zs % Egg g From the FIN specs screen, select
302 WEAR & TEAR Yes Back-End No 0.00 O .
,; S: ;n;;DA::Z\::DEEL Demo Tire And Wheel :es gac»:nj zn EEE g Aftermarket PrOdUCt Malntenance
Sha [T e Euemele 5 wed found under ODS Utilities. Registered
Ry — %iﬁi %iii:f!:d %5; % e g provider(s)/product(s) can be selected
10 | AFT15 | AFTMKT 15 No Front-End No 0.00 . . .
i1 AFrse | et rorecron Demo Theft Protection za iackandd zn o0 g to default for each individual aftermarket
12| arrie | arrer 10 ] o L — — code when rating.
15| AFT20 | TBW (+] no (~] Front-End [~] no (=] 0000
16 | AFT21 | PAINTLESS DENT REPAIR, Demo Paintless Dent Repair |~ | Yes (=] Back-End (=] No = 0.00 O
e o %ZZ %:;it;i?%z: % E:EE% Now you are ready to rate and
19 | AFT24 | AFTMKT 24 No Back-End No 0.00
o [ ol — L — book your products.
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Rating and Booking

Product Rating
Rating from a deal record in ERA-IGNITE or Desking

© (Desking - 27/01 23798 5 - TRAHAN, HANG;) - Sales and F&l - o x Step 1 YOU can rate products from the

FIN Functions  File bscreel Tools Display Reports Print System Tools Go To
cosomer HSE9@8 4@« -8 Y BRI i Aftermarket, Warranty, and GAP
ehicle [:BCMOTORSPORTS |

i PyrET— subscreens or by clicking on the

Prior Lease Balance 2 [}

e | o |

Insurance ~Sales Price——————— ~Down Payment. ~Payment i i i
CerrmE Ry Customer Cash Term A corresponding icons in the deal
Discount Deposit Sell Rate H ( ) H
L e rres B ta | s worksheet, or access the window(s) in
- Aftermarkets Total Trade Allow B[ 0.00] | | % Amt Financed
e e the Subscreens menu that corresponds
VI Premium Total Net Trade 0.00 | | # Days 1st Payment
De;‘er . ESC Premium Total Trade ACV Payments Per Year tO the prOdUCt
] —_— ;Fm Total Def Down [S] 0.00 | | 1stPaymentDate [04/19/2018 [@]
Vendor 3 GAP Premium Total Down Payment 2,000.00 | | Prepaid Fin Charge
v aci . .
Note: VIN and Mileage are required

Deferred Pymi; -
;E e‘”e a— Cert Priorlease Bl B[ 0.0 Amount Financed 25,704.06 g q
mploses 1| | Licenss Fee Finance Charge 2,675.34 to rate products.
Recap

) Dealer Fees (5] 0.00 Total of Payments  28,370.40
Commissions UCK Total Fees B 104.00 Total Sales Price 30,379.40
Uiy 0| Total Taxes B 14206
We Owes D 143 Total Frice 27,704.06 Payment 472.99

. o

s [ sapmsomas Wowes Zow o Step 2: Click the Get Product Pricing button

o 1 et ] o [ (on the Warranty or GAP Company
Polyumber [ Outside Finance [ 5] Worranty Class [ ] . . .
Cotnr [ mosenen e [ T S window) or the Shopping Cart icon

i L) | O | O || O = in the Get Pricing column (on the

e premium 000 Cso 000 Cso [ 000 Cs0 000 D50 . .

— o e i Aftermarkets window) to display the
= B B B P =R Product and Rating Request window,
Aftermarket: Deductbl [ ] [ ] ]

ol e | T P o — where product pricing can be retrieved.

Taxes & Fees A0A A0A A0A AOA

s Delete Delete Delete Delete

Deferred byons S— S—
s
Recap
Commissions
Titing TotalPremiums 000
GAP Compan: Ahermarets &)
Suppress Senstve o [I Alerts %3 Print ¥ g VM Alerts
Deal Notes % Suppress Sensitive Info [J Alerts % Print W éuw Alerts i suppess seoswe o [l e et v g ovm e
Aftermarkets
GAP Col
mpany
- Current Sel T e [
e = O Customer Code | Descrption e Price |0 Cost| Handing
vehide
) Vetide T[T [ ToX001 [=] THEFT PROTECTION ] 000 0.00] Financed/Coptalzed [~
e Premium (Manual) P [ ] Iradeln 210 ] 000
Vehicle Cost Rated Product Prior Lease Bal 30 - | ] 0.00 0.00
Tradenn e 5 5 i [ [ —
— [ Name [ Premium [code | " Miscellaneous s 10 5 g i) 0
n 1 SAFE-GUARD HYUNDAI GAP MANUAL ENTRY SGH Worranty 710 B ] 00|01 000
———— 2 ALLED GAP INS CALCULATION a AP Company ¢ 19 = g e g G
Miscellaneous y s = 000 000
Miscellaneous 4 ARCH INSURANCE CO CALCULATION 6 et psrance (|01 = ] 00001 000
Warranty 5 OLD REPUBLIC CALCULATION 7 Aftermarkets | |11|0] @] ] G
AP Compan 6 TRAVELERS INSURANCE MANUAL ENTRY 1 Rebates 2|0 m] o000 000
. 7  GEICO INSURANCE MANUAL ENTRY 2 Dealer Fees = g E i E i
Credt Insurance 8 PROGRESSIVE INSURANCE MANUAL ENTRY 3 Toxes Fees e T = e e
Aftermarkets 9 GAP PROTECTION MANUAL ENTRY 101 vendor 16/0 B ] 000[0] 000
Rebates 10 INFINITI GAP MANUAL ENTRY G1o peteredpymts | 1701 - ] 00001 000
10 - ] 00001 000
—— 11 HONDA GAP PROTECTION MANUAL ENTRY o0t Employees g - = e a0
12 TOTALLOSS PROTECTION MANUAL ENTRY 002 Reaap 2[00 - ] 00001 000
Taxes & Fees X X
Toxes & Fees 13 CNAGAP MANUAL ENTRY cna Commissons p 5
Vendor 14 SAFEGUARD GAP MANUAL ENTRY 603 Tting Al Aftermarkets Total:
Deferred Pymts 15 BMW GAP MANUAL ENTRY o4 We Owes We Owe Total:
Cmplovess 16 MERCEDES BENZ GAP MANUAL ENTRY 605 e oot en ot
o GAP | Get Product Pricing CEr el
Recap
Commissions
Titlng
Ve Oue: Qsack_next £
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Product and Rating Request o x
Vehicle Information
VIN 1FTEX1CB3FB13119 Deal Date 03/05/18 New/Used/Demo New
Vehicle Description 2018 FORD TRUCK F-150 2WD SUPERCAB
Odometer Rating In-Service Date [03/05/2018 (@]
Used Vehicles: Active Manufacturer Vehicle Warranty Original Owner
Product Information
Product Type 1 Prompt Miscellaneous Product Option
Provider/Product Demo VSC i} Use Retail Price in Deal
Plan Deductible [ Product Price| | Surcharges Price
Flan Name Base Froduct Price 0.00
Form Number Selected Surcharges 0.00
Limited Warranty Total Product Price 0.00
Provider Deductible Description
= = deductible is reduced to the listed price
== = deductible is reduced to zero
I Get Fricing [FS' Cancel
Miscellaneous Product Options
~Surcharge
Surcharges
~Miscellaneou:
Rate Book Code | =]
Lender Code | =]
I OK (F12) ' Cancel

Product and Rating Request
Vebhicle Information
VIN 1FTEX1CB3JFB13119
Vehicle Description 2018 FORD TRUCK F-150 2WD SUPERCAB

Deal Date 03/05/18 New/Used/Demo New

Odometer Rating In-Service Date [03/05/2018 (8]

Used Vehicles: Active Manufacturer Vehicle Warranty Original Owner

Product Information

iy EE I Prompt Miscellaneous Product Option I
Provider/Froduct [Demo VSC RG]

Flan Deductible [ FroductPrice| | Surcharges I Price|
Plan Name Base Product Price 0.00
Form Number Selected Surcharges 0.00
Limited Warranty Total Product Price 0.00
Frovider Deductible Description
* = deductible is reduced to the listed price
** = dedudtible is reduced to zero

Get Pricing (F5) cancel

Step 3: In the Provider/Product Aeld, select the
provider and product to obtain pricing for.
Use the dropdown arrow in this Aeld to
display registered providers. Then click Get
Pricing (F5) to rate the selected product
and display plans and pricing.

2 The padlock can be toggled on or off
to display or hide cost and proAt
amounts. This option is available
based on security access.
Note: If Automatically Rate was checked

in the Additional Controls, the Get
Pricing step would be skipped.

Step 4: If there are any surcharges that may apply,
the Miscellaneous Product Options window
will display. Select surcharges as

necessary and click OK (F12).

Step 5: You can turn the prompts on or off or the
miscellaneous product option using the
checkbox labeled ‘Prompt Miscellaneous
Product Options’. Also, if a price is
established in a deal but rating will still be
necessary for cost, check the box for ‘Use
Retail Price in Deal.” When the product
is saved back to deal, the retail price
will not be altered but the correct cost/
plan information will reAect for booking
purposes.

Note: If you choose to skip the Misc
Product Options screen, selections can
be missed that may result in improper
ratings for certain providers/products.
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Product and Rating Request o X
Vehicle Information
VIN 1FTEX1€B3JFB13119 Deal Date 03/05/18  New/Used/Demo New
Vehicle Description 2018 FORD TRUCK F-150 2WD SUPERCAB
Odometer Rating In-Service Date [03/05/2018 (&]
Used Vehicles: Active Manufacturer Vehicle Warranty Original Oviner
Product Information
Product Type  ESCL Prompt Miscellaneous Product Option
Provider/Product [Demo VSC [GN:] Use Retail Price in Deal
Plan [~ Deductible | product Price| | Surcharges Price
Basic Wrap 0.00 1262.00 O 1 ton or greater 320.00
@ Bronze WEB. 1 s0.00 1062.00 1 4x3/AwWD 300.00
Discountable Regulated Flan 1 100.00 862.00 [ Commerdial Use 300.00
Gold - New Vehicles [ 100.00/0.00== 662.00 [ Diesel 75.00
B Gold wrap O 200.00/50.00* 800.00 [ Electronic High Tech 75.00
0 12/12000 O Hybrid 100.00
[ 24/24000 [ Seals & Gaskets (0-100,0... 50.00
36/36000 [ seals & Gaskets (100,00... 75.00
L1 48/43000 [ Technology Fackage 100.00
[ 60/65000 v 1 Turbocharger 150.00
Plan Name Gold wrap Base Product Price 1262.00
Form Number  DAP DemoForm_WARRANTY Selected Surcharges 0.00
Limited Warranty /A Total Product Frice 1262.00
Provider Deductible Description ~ $0
* = deductible is reduced to the listed price
== = deductible is reduced to zero
[ Get Pricing (F5) i Save Product (Flz! Cancel

Rating from F&I Menus presentations

Package ltem Properties

Ttem Settings | ltem Appearance |

Vehicle Appearance Protection Package ltem Settings

] Allow Runtime Editing

Premium Markup— () % —(@® §

Minimum Markup
Maximum Markup

Maximum Discount—-() % —(®) $

Maximum Discount

Custom Tag1 | |

Ttem Name [vehicle Appearance Pmteclm je— 1 Allow zero Price
LD Afteriariettem (7] Allow Discount [ Allow Zero Cost
Aftermarket Code  [AFT13 - winoow ETcH_[~] ] Allow Cost Allow Zero Mileage
LAH Type = Allow Warranty Data || Allow Zero Months
Flan Name [ ] Allow Deductible  [] Allow Custom Tagl
Manths [0 Allow Custom Tag2
(= Presentation File [
Deducitio Ttem Description
Retail Price Waintain showraom condition. Protects paint from £
. bugs, tree sap, bird droppings and other
pollutants. Protects interior fabric and leather from
Sale Price fading and stains
cont

Decliner Statement

Disabiltty Disclaimer

custom Tag2 | ]
Provider/Product |Dema Appearance Protection
&utomaticallv Rate when Editor.is sele

Step 6: Select a product and plan by clicking
the plus sign which displays available
policies within that plan. Choose
a policy by placing a check in the
appropriate box and then choose a
deductible. If any surcharges were
returned, they will be listed in the
surcharge box. Click Save Product
(F12) to add the product to the deal.
The deal record is automatically
updated with the pricing information
for the product. Details for the product
are recorded on the Warranty, GAP
Company, or Aftermarket window as
appropriate.

Note: Changing certain details in
the deal record, including but not
limited to the vehicle information
and deal date, may require you to
re-rate or re-book the product to
reflect the changes.

F&I Menu Designer-Setups
Go to Tools > F&l Menu Designer

Within a menu, double click a product
to open Package ltem Properties.

In Package Item Properties, you
have the option to default a provider/
product for that particular package
item in the menu. You also have

the option to check the box to
Automatically Rate when the Editor
button is selected.
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e Step 1: Select a Menu package to rate

Guest Vehice Date 03/05/2018 LiZ2PM
HANG TRAHAN 2018 FORD TRUCK F-150 el Namber . . t
1200 IRVING PLACE 24D SUPERCAD b | heckmark h
SAINT CHARLES MO 63301 VIN: {FTEX 1CB30FB13119 - | — y p aCIng achec ark in e
Mies: 12 ansger

Amount Financed 22566.25) Down Payment 2000.00] Rate [ 5.5 Total Rebate :::Z:Z:t:z::nma/ﬂm appropl’late bOX. Then C“Ck the Editor
Sale Price Term NetTrade | .

button next to a package item to
enter the Editor window.

Economy
Vehicle Service Contract Vehicle Service Contract Vehicle Service Contract

s Costs of parts and labor on covered | [« Pays costs of parts and labor on covered | [+ Pays costs of parts and labor on covered
repairs for 36 months or 36,000 miles, with a| |repairs for 36 months of 36,000 miles, with a|
$0.00 dequctible 50.00 deguctible.

$1262.00(@623.22/mth) $1262.00(@623. 22/mth)

T eRais for 36 months or 36,000 miles, with a|
400 deductivle.
$1262.00(@$23. 22/mth)
GAP Protection GAP Protection
s difference between actual cash value | Pays difierence between actual cash value
loan balance if your vehicle is declared| |and loan balance if your venicle is declared
tal loss due to theft or collision a total loss due to theft or collision
@¢13.52] ¢t

Preferred

Vehicle Service Contract
+Pays Costs of parts and [abor on Coverel
repairs for 36 months or 36,000 miles,
$0.00 deduciiole.

$1262.00(@$23.
U GAP Protection
Pays difference between actual cash
and loan balance i your vehicle is decl
atotal loss due to theft or collision
@s13.5

Note: To select the Editor button,
the Allow Runtime Editing option
must be checked in F&l Menu
Designer > Package Item Settings.

Vehicle Appearance Pr...
lizintain showreom condition. Protects paint
from bugs, tree sap, bird droppings and other
pollutants. Protects interior fabric and leatner|
from fading and stains

Vehicle Appearance Pr...
Waintain showroom condition. Protects paint
from bugs, Iree sap, bird droppings and other
pollutants. Pratecis interior fabric and leater
from fading and stains

$400.00(@47.36 /mth) $400.00(@47.36/mth)

- Window Etch
Window etch deters professional vehicle
theft

$298.00
Package Total Price $1662.00 Package Total Price $2357.00 Package Total Price $1957.00 Package Total Price $1262.00
Package Discount $0.00 Package Discount $0.00 Package Discount $0.00 Package Discount 0.00
Package Price $1662.00 Package Price $2397.00 Package Price $1997.00 Package Price $1262.00
Term s oefe@] O Term #o[e] ©[7z]Tem # o] ©[72]tem Fofe]
Rate Rate Rate Rate
Customer Iifil Cusiomer Ifial: Customer Tl Customer Infial

Vehicle Appearance Protection Editor x Step 2: Click Get Pricing (F5) to display
Vehicle Appearance Protection the Product and Rating Request
Aftermarket [AFTMKT 13 | CustomTag1 | | window, where the products can be

Aftermarket Code Custom Tag 2 | | rated.
Retail Price
Discount
Sale Price

[ Apply to All Package Items Get Pricing (F5) oK Cancel

£ Step 3: After selecting the desired product

Vehicle Information

VIN 1FTEX1CB3JFB13119 Deal Date 03/05/18 MNew/Used/Demo New and p|an on the PrOdUCt and Ratlng

Vehicle Description 2018 FORD TRUCK F-150 2WD SUPERCAB.
Odometer Rating In-Service Date Req uest W|nd0W press Save

Used Vehicles: Active Manufacturer Vehicle Warranty Original Owner ’

Product (F12) to close the window

Product Information

Product Type  Aftermarket Aftermarket Code AFT13 Prompt Miscellaneous Product Option .
prowder/product [Demo Appearance Frotection ] A O use Reta Pice n Dea and automatically enter the amounts
Product Price. Deductible Product Price Surcharges Price
5 gpearance Protecion — S for the selected product on the
0 12712000 325.00 . .
O 24/24000 425.00 Editor window.
36/36000 525.00

Step 4: Click OK to save the package
e, e E item and return to the F&l Menus
Total Product Price 525.00 . .
window, where the package item
Provider Deductible Description ~ $50
has been updated.

* = deductible is reduced to the listed price

** = deductible is reduced to zero

Get Pricing (F5) Save Product (F12)}  cancel
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Rating from docuPAD - Customize Deal Menu

5 AN, HANG (De e [m) x
Finance Option 1 Term Pmts/Yr Rate Base Payment 1 884.32
[JFinance Option2 Term || Pmts/yr [ | Rate[ |  Base Payment2 A
Denny 1 Denny 2 Denny 3 Denny 4
Dent Restore Plus - 3 Years Ownershield Tender Loving Care - Platinum Combo CLAH test
Retail Price [, = 100.00 ||| Retail Price %, = 1.00]|| Retail Price % =1 566.33 ||| Retail Price %, =1 0.00
Months 36| Months 0] (| Months 0]||cost 0.00
Deductible 0.00] || miles 0] (| miles 0]||Replace Select Coverage
Cost Deductible 0.00] || Deductible 0.00 ‘Allied GAP - GAP
Cost 0.01] || Cost 0.00
Key Replacement - Standard Select Coverage ||| Replace Select Coverage ||| Retail Price & 0.00
[ ABSOLUTE Tire & Rim Protecti... |||  Ford Protection Plan - Basic G... ||| Months 0
Retail Price %, 5 399.00 Miles 0
Months 36 || Retall Price % = 199.00] || Retail Price % 1 0.00] || peductible 0.00
Miles 0] || Months 36] || Months 0]|| cost 465.00
Deductible 0.00] || Cost 79.00 ||| Miles 0]||Replace Select Coverage
Cost 199.00 Select Coverage ||| Deductible 50.00
Replace Select Coverage AFTERMARKET 1 - AFTL Cost 0.00
Tire & Wheel Protect Replace Select Coverage
Retail Price % 200.00 Car Care Upgrade - Elitel Hon __|
Retail Price [, = Months 11
Months Miles 11000 || Retail Price % =1 349.00
Deductible 111.00] || Months 0
Cost 20.00] || Miles 0
Theft Protection Select Coverage ||| Deductible 0.00
Service Cost 0.00
Retail Price & = 0.00 Replace Select Coverage
Months 0]||Retail Price % =1 0.00
Miles 0] (| miles 0
Deductible 0.00] || cost 0.00
Cost 0.00] || Replace Select Coverage
Replace Select Coverage

Vehicle Information
VIN 1FTEX1CB3JFB13119

Odometer
Used Vehicles:

Product Information
Froduct Type  ESC1

Deal Date 03/05/18
Vehicle Description 2018 FORD TRUCK F-150 2WD SUPERCAB

Rating In-Service Date [03/05/2018 (]

Active Manufacturer Vehicle Warranty

New/Used/Demo New

Original Owner

Prompt Miscellaneous Product Option

Provider/Product [Demo VSC

Use Retail Price in Deal

&

Plan

Deductible

[rroauerea] |

Surcharges

Price

Flan Name
Form Number
Limited Warranty

Frovider Deductible Description
* = deductible is reduced to the listed pri
== = deductible is reduced to zero

ce

Base Product Price
Selected Surcharges
Total Product Price

I Get Pricing (FS)I

0.00
0.00

Cancel

o x
Vehicle Information
VIN 1FTEX1CB3)FB13119 Deal Date 03/05/18  New/Used/Demo New
Vehicle Description 2018 FORD TRUCK F-150 2WD SUPERCAB.
Odometer Rating In-Service Date [03/05/2018 [&]
Used Vehicles: Active Manufacturer Vehicle Warranty Original Ovmer
Product Information
Product Type  ESC1 Frompt Miscellaneous Product Option
Provider/Product [Demo VSC QRG] Use Retail Price in Deal
Plan [~] [ peducuble [ Product price| | Surcharges Price
Basic Wrap 0.00 1262.00 O 1 ton or greater 320.00
Bronze WEB O s0.00 1062.00 O 4xafawn 300.00
Discountable Regulated Flan 1 100.00 862.00 O Commercial Use 300.00
Gold - New Vehicles 1 100.00/0.00** 662.00 O piesel 75.00
B Gold Wrap [ 200.00/50.00= 800.00 O Electronic High Tech 75.00
0O 12/12000 O Hybrid 100.00
O 24/24000 O Seals & Gaskets (0-100,0... 50.00
36/36000 L seals & Gaskets (100,00... 75.00
O 48/48000 O Technology Package 100.00
] 60/65000 v LI Turbocharger 150.00
Plan Name Gold wrap Base Product Price 1262.00
Form Number  DAP DemoForm_WARRANTY Selected Surcharges 0.00
Limited Warranty N/A Total Product Price 1262.00
Provider Deductible Description ~ $0
= = deductible is reduced to the listed price
=* = deductible is reduced to zero
Get Pricing (F5)| Save Froduct (F12){  cancel

Step 1:

Step 2:

Step 3:

Go to FIN Functions > Attach
docuPAD Menu. When the docuPAD
Menu Select screen opens, choose
Menu and click OK. Within the
Customize Deal Menu screen,

click on Select Coverage for the
required product.

Click Get Pricing (F5) to display the
Product and Rating Request window,
where the product can be rated.

Note: The system can be setup

to default the provider/product
as well as automatically rate
when select coverage is selected.
For assistance, please contact
docuPAD support.

After selecting the desired product
and plan on the Product and Rating
Request window, click Save Product
(F12) to close the window and
automatically enter the amounts for
the selected product on the Coverage
window.
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Coverages
e Note: It is very important to verify
_— ST that the coverage shown in the
Expiration Date [03/05/2023(@]  Expiration Miles -
- — Available Coverages matches
C a X
e with the plan selected under
AddOns Available Coverages: Selected Coverage
- Retail Price Rated . .
ridore o — = . Product Rating and Booking
OO ADDON 4 ADDON 5 Terms | — | Deductible | — Miles
Coverage changed afer Product was Rated. Expiration Date Expiration Mi Selected Coverage. For example,
Check Selected Coverage values.
—.m"’“;m““.= e “Coverage2” was a change that no
Terms 60/ 60000 ns
ﬁfims m longer matches the VSC Gold.
‘ oo OooiE e
5 = 2 Belected Coverage
Get Pricing ()| save to all aptions || save to this option || cancel

3/20 a
Coverages
Available Coverages Selected Coverage
Coverages |COVERAGEL ﬂ Retail Price 756.00 Rated
Deductbles [ [=] Cost 756.00) Months
Tems [T Deductble [ ] Miles
Expiration Date |03/05/2023 (] Expiration Miles
AddOns
AddOns ‘ ‘
ADDON 1 1| ADDOM 2 ADDON 3
] ADDON 4 ADDON 5 | ADDON &
Product Rating and Booking Selected Coverage
Plan Name VSC Gold (N)
Terms 60/ 60000
Get Pricing (FS)I Save to all options H Save to this optlonl Cancel
C HAl fe u} X
Finance Option 1 Term Pmts/r [ 3] Rate Base Payment 1 884.32
[ Finance Option 2 Term || Pmts/yr[_|  Rate Base Payment 2 n/A
Denny 1 Denny 2 Denny 3 Denny 4
Dent Restore Plus - 3 Years OwnerShield Tender Loving Care - Platinum Combo CLAH test
Retail Price % 100.00 ||| Retail Price % 1 1.00 || Retail Price % 51 566.33 ||| Retail Price # 0.00
Months 36 | || Months 0 || Months 0]|| cost 0.00
Deductible 0.00 ||| Miles 0| Miles 0] || Replace Select Coverage
Cost 50.00 ||| Deductible 0.00 ||| Deductible Allicd GAP - GAP
Replace Select Coverage ||| Cost 0.01
Key - Standard Select Coverage Retail Price %, 1 0.00
Tire & Rim Protecti... Ford Protection Plan - Basic G... ||| Months 0
Retail Price % =1 390.00 Miles 0
Months 36 ||| Retail Price % =1 199.00 ||| Retail Price % =1 0.00 || | Deductible 0.00
Miles 0 (| Months 36 ||| Months 0]|| cost 465.00
Deductible 0.00 ||| Cost 79.00 | || Miles 0] || Replace Select Coverage
Select Coverage | || Deductible 50.00
AFTERMARKET 1 - AFT1 Cost 0.00
Replace Select Coverage
Retail Price % 5 200.00 Car Care Upgrade - Elitel Non ..
Retail Price % 7 165.00 | | Months 11
Months 36 ||| Miles 11000 ||| Retail Price % =1 349.00
Cost 165.00 ||| Deductible 111.00 | || Months 0
Replace Select Coverage ||| Cost 20.00 | || Miles 0
Theft Protection - Road Hazar. Select Coverage ||| Deductible 0.00
Service Agreem... ||| Cost 0.00
Retail Price % 7 0.00 Replace Select Coverage
Months 0]||Retail Price % = 0.00
Miles 0| Miles [
Deductible 0.00 ||| Cost 0.00
0.00 ||| Replace Select Coverage
Select Coverage
e ——
PRODUCT TEST 02/13/2017 - ...
Retail Price % 71 & 756.00

Step 4: Select Save to all options or Save to
this option.

Step 5: Once all applicable products have
been rated, select Ready for
docuPAD (F8).

Note: The icon will serve as
an indicator that the pricing was
obtained through Product Rating
and Booking.
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Rating from docuPAD - Menu of Options

Edit PAEKEGE Tarms

NEW CAR LOAN

u of Options

Step 1: Flip the workstation screen so

[Denny 2

‘Custom Eyes, Custom. Denny 3 Custom Ey Denny 4 Custom E; H
[Benny Gmon e Gotminy | Denny GetmEw) | Denny iy that the Edit product buttons are
IYIOM Restore Plus -3 Si00 3 OwnerShield $1 (s0ipmt) ;Inr:iar Loving Care - 9566 (5190 Combo CLAH test € 50 (stvpm))
‘ears 0 deductible latinum if H . . -
38 months /0 deductble «» ki €D et | | ettt o combo nsrane procut S available. Click on the Edit button to
= ABSOLUTE Tire & Rim $199 (S7/pmt), - - — -~ e

ggl §;r|;llnamlm - 22015000 Protection - 3 Years a;d'dmmon Plan - Basic 50 (sopmi) :mns‘:: -GAP 50 (S0fpmb) . .

o il @ el e e S o L open the Product Editor Window.
+ Key Replacement by coversd road hazards " G Prtection Plan

I —

Tire & wr;ra'e.l (Pmlymlon TS MARKET 1 -AFTA 200 67 ﬁ::‘ q;yl;‘e Upgrade - Elite1 5342 (5110m1)

hmods 41 months / 11000 miles /111 dedUC' TR o deductible [ Ear

+ Tire & Wheel 3 s 4 s

Service Maintenance 0 (S0/pmt),
'rnen':rgmlon -Road 0 (Seiprat) Lomon #:]f:lane.gnﬂ:dner -
e intenance

Hazar overage Ean ) ety

PRODUCT TEST §758 (525/pmt) | |+ See contract for official terms and conditions

02/13/2017 - COVERAGE1

60 months / 60000 miles / 0 deductible

- Covers sevicing your v for e temof

coveraos
- Sa6 st forffil s and condons

Product Editor

Step 2: Select Get Product Rating to open

Dent Restore Plus - [3 Years]

RA23PL1173NA (10/06)

Caverage

Deducible:

s

the Product Rating Request modal.

Deductible

Step 3: Click Get Pricing to rate the product.

cansre i)

Product Prica Surcharges
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Product Rating Request _I‘@

EEE e

Deductible Product Price Surcharges

Product Editor
Dent Restore Plus - [3 Years]

RAZ3PL1173NA (10/06)

Coverage:

Dedugtible

Product Raling Selected Coverage:

||}||l)||h

Step 4: Choose the appropriate product

plan name and coverage from
the dropdown lists and click
Save Product.

Use either Save to This Package or
Save to All Packages to save the
product information and return to the
Menu of Options screen.

Note: In the product editor window,
Rated will display next to the
coverage dropdown. The rating
information displays in the bottom
left of the window.

Confidential & Proprietary Information of the Reynolds and Reynolds Company © 2019




Product Booking and Printing

[m) X
lSmartForms |F&l Forms Menu =
(@) Dealer Description () Standard Description
E ‘ Dealer Description 51‘ Type Status | Custom ‘ Category ‘ Preview ‘Vo\d ‘ Misc. dP &
[ 65 | WELLS FARGO CONT-OH (03/02) Impact NONE
[] 243 | WE OWE FORM (NO REV) Impact MISCELLANEOUS
1 3 | WEOWE (11/95) Laser MISCELLANEOUS
[ 349 | WE OWE (03/13) docuPAD MISCELLANEOUS Preview First Form
[0 72 | vATITLE AFP (12/05) Laser STATE FORMS/TITLE APP...
[0 4 | vAREGISTRATION APP (07/05) Laser STATE FORMS/TITLE APP...
(] 102 | VA BUYERS ORDER-M (MO REV}) Laser MISCELLANEOUS
[ 101 | VA BUYERS ORDER-A (01/02) Laser MISCELLANEOUS
[1 57 | US BANK CONTRACT-OH (01/02) Impact RETAIL CONTRACT
[ 15 | US BANK ATPL Impact AGREEMENT TO PROVIDE ...
[] 258 | UNITED CAR CARE VIPCA-WA (07/05) | Impact ESC/WARRANTY
(1 201 | T TT/PMT VERIFICATION (08/05) Impact STATE FORMS/TITLE APP...
[ 200 | TX TT/PMT VERIFICATION (01/05) Impact STATE FORMS/TITLE APP...
1 199 T TT/PMT VERIF (10/00) Impact STATE FORMS/TITLE APP...
[] 206 | T TRADE3 POA-PDF (11/08) DP docuPAD STATE FORMS/TITLE APF... | Preview
[ 205 | TX TRADE2 POA-PDF (11/09) DP docuPAD STATE FORMS/TITLE APP... | Preview
[ 204 | TX TRADEL POA-PDF (11/08) DP docuPAD STATE FORMS/TITLE APP... | Preview
[1 141 | TX TITLE ISSUE CNTY-PDF(02/11) Impact STATE FORMS/TITLE APP...
(] 140 | T TITLE APP-PDF (05/12) Impact STATE FORMS/TITLE APP...
(] 202 | TX TITLE APP-PDF (04/11) Impact STATE FORMS/TITLE APP....
[ 203 | TX SOLD POA-FDF (11/09) DP docuPAD STATE FORMS/TITLE APP... | Preview v
] Skip Hidden Prompts [ pisplay docuPAD Farms Only Refresh (F5) Print (F10)
Print Queus
[ |
[ select All Forms [ Print All Impact/DP Forms as docuPAD [ Print All Pages (docuPAD only)
ot fsoka A et Rutedte eContac ms.
Provider/Froduct | Plan/Praduct |contract | Provider Status | docuPAD |
Sign an docuPAD
[1 Demo Appearance...| Appearance Protection o < cloct Unboked
[ pemo GAP GAP - All fields required
1 Deme vsC Gold - News Vehicles Book Contract (F3)

e

Additional Fields Enter Additional Data

Enter the Tire Size
Enter the Tire Description
Enter the F&I Managers Name

[ ok |

Cancel I

Once a product is added to a deal, you can

book the contract from the F&l Forms window,
accessed by selecting Print > F&lI Forms. On this
window, simply select the product to book in the
Aftermarket Product Booking and Reprint section
and click Book Contract (F9).

You can also choose Select Unbooked to book
all products simultaneously.

Once you select and Book Contract (F9) you will
get an option to preview the form(s) on screen or
print automatically.

A contract number assigned by the provider is
automatically entered in the Contract # column
and the status is changed to Booked.

Note: When “Sign on docuPAD” is checked,
the PDF will load to the docuPAD workstation
Forms & Documents screen where it can be
signed electronically. If this is not selected,
the completed contract will automatically
display in a separate window to be printed
and processed as usual.

If there is any missing information required to
properly book a product, the Additional Fields
screen will prompt you to enter the necessary
info. This screen is meant to capture required info
that may be missing, as specifed by the provider,
so forms will be Alled out correctly. It also ensures
that providers have all necessary info to properly
service the customer.

Once booked, the completed contract form
automatically displays in a separate window in
.pdf format. Information for the buyer, vehicle,
and product is automatically entered on the form.
You can then print the form for the buyer to sign,
and process it as usual. Repeat this step for each
contract you wish to book.
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5C Rating and Products Displa O %
Provider/Product Plan/Product Rating Price | Rating Cost|  Deal Price Deal Cost| Contract#
Demo Tire And Wheel Tire & Wheel 400.00 400.00 400.00 400.00 | RYNODO15818
Demo GAP GAP - All fields required 55.00 55.00 55.00 55.00 | RYNODO15817
Demo VSC Gold Wrap 862.00 862.00 862.00 862.00

Product Type ESC1 Aftermarket Code

Original Rating Price (No Markup) 862.00 Original Rating Cost (No Pack) 862.00

Date Saved 03/05/18 14:20:57 Date Booked Date Voided

Book Contract
VSC Rating and Products Displa W] X
Provider/Product Plan/Product ‘ Rating Prlce| Rating Cost‘ Deal Price Deal Cost | Contract#
Demo Tire And Wheel Tire & Wheel 400.00 400.00 400.00 400.00 | RYNDDO15818
Demo GAP GAP - All fields required 55.00 55.00 55.00 55.00 | RYNDOD15817
Demo VSC Gold wrap 862.00 862.00 862.00 862.00
Product Type Aftermarket Aftermarket Code AFT12
Original Rating Price (Mo Markup) 400.00 Original Rating Cost (No Pack) 400.00
Date Saved 03/05/18 14:19:46 Date Booked 03/05/18 14:23:42 Date Voided

I Reprint Coﬂtractl Void Contractl Close

You can also book contracts by selecting Display
> VSC Rating and Products. The VSC Rating
and Products Display window displays a list of
the rated products on the deal.

Note: If the label “Rating Only” displays for the
provider on this window, the product must be
booked with the provider outside of the Sales
and F&l application.

If a buyer changes their mind about a product,
you can easily void the contract directly from
the VSC Rating and Products Display window
by highlighting the product and clicking Void
Contract.

Note: Contact providers directly for specific
guidelines regarding voiding contracts.

You can reprint forms by highlighting the product
and clicking Reprint Contract.

IMPORTANT

Remember to contact your provider(s) about their speciAc processes as some providers require

additional steps to be taken in order to properly void contracts.
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Build a Remittance Report

A Remittance Report can be built within the ERA-IGNITE Retail Management Intelligence (RMI) application.
This report will show the contracts booked as well as the actual contract numbers. To build this report,
complete the following steps.

Step 1: Open the Retail Management Intelliaence Application found under My Applications on the ERA-IGNITE

homepage by simply clicking the icon found on your toolbar.

1221 (RMI) - ERA-IGNITE - a x

Functions

Step 2: Go to File > Add Dynamic Report.
Reports  Print  System Took Go To
A S COINQeraFECD B A |® When the new screen appears,
Search/Change Dynamic Report ctri+s ) A
BT select Blank Report and then

rici| Completed Reports | Scheduled Reports | X
: click Add (F12).
[PPD26 Owned By | (@] Report# [ |
[ ] Run Since | (=]
[&] RunArea ~] swre [ =] sranch [ [=]
Iy MEtries

Dynamic Reporting [ seercn () | [seectFr) [ clear | Note: You will need to be in the
boct Search Results
- i I p— T F&l store and branch where the
e Ad current report 1o Favortes e S remittance report is required.
[ Exception Reports %y
[[Becouriing Reports
[ Fapesting Reports
Deal Activity Log
F&d Audit Report
F&I Management Report
Finance Reserve Analysis Report
Heat Sheet Report
Inventory Ana\ys\s Report

uick Vehicle Advance Repor - 1 H ”
T — . . Step 3: Name the report “Remit Report” and
Sales DOC 4: SALES DOC 4 v
F1] Help F2 F3] Change Store/Branch Fa F5) Search F& name the Data Set
F7 Fg F3) Add New Fid Fil Fi2 select as “F|MAST_FAND|”

>
[ [ [RMILDRPT _ [PPD26 B7/FANDIOL [A62/80069 [OVR [5177

Applications  Tools

» o«

) (RMI) - ERA-IGNITE - O x . i H i
= Step 4: Select the following Criteria.
Functions File Applications  Tools Reports Print  System Tools Go To
O#Hd PN eQEaFrEa= B AR
-"’5"”8"”5““‘ %  Dynamic Reporting Editor
# 27{FANDIDL Report # 1601  Report Title Remit Report
‘Open Road Motors (fandio1)
| Basic Info | Criteria | Output | Sort/Total || Advanced | Additional Users |
[ User-pefined Reports 2 =
@ Dashboard ( Field Condition iz’""are ‘Value/Fle\d ‘) Andfor SE:‘“ =
; :
6*‘_‘;9%‘“? Z:::Lcmm\ (=] PEN-CONTRACT-NUM-L [&] #  [~] Value [~] [*Tor =] O
Monthly Metrics
e (=] PEN-CONTRACT-NUM [=] value [~] [zJor 7] OO
Dynamic Reporting (=] PEN-CONTRACT-NUM [=] value [=] (FJor (7] OO
boct (=] PEN-CONTRACT-NUM [] value [+] [*Jor [~] OO
-nFMmes = oA PEN-CONTRACT-NUM Value (] And [m]
S e [ e ofTiag-
[ Bxception Reports * e [ sTar [~] value [] cFE EEROENG g
[ - .
E s -
Fe— ;
Pl e 3
[[Security/systems Reports ¥
[ .
[[Wehicle Management Reports ¥
F1) Help F2) Lst F3) Change Store/ranch  [F4 i 78 Add Function
F7 78 3] Fid i Fi2 add
B
[ [Record Add In Pro... RMIYRPTO  [PPD26 P7/FANDIO1 [A62/80069 [OVR [5084
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RMI) - ERA-IGNITE - o x
Functons Fle Applcations Took D Reports Print  System Tooks Go To
o# HAP[EENeDwuFESEA|R
[{Ghange Store/eranch % Dynamic Reporting Editor
# 22/EANDIOL Report # 1601  Report Title Remit Report
Open Road Motors (fandi01)
Basic Info || Criteria | Output | Sort/Total | Advanced || Additional Users
Reports
e —
@ Dashboard " i
@ Daily Operating Control Field Column Title width | Format L/R | MV Option A [a)
Monthly Metrics DEAL-NO %] DEAL-NO 7 L = L]
Dynamic DEAL-DATE = | DEAL DATE 10 mMM/DD/YY []|R [+
DOC+ B-NAME % BUYER NAME 60 L[~
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Step 5: Select the following Output.

Note: You can add other columns
you would like to pull, such as
MAKE.

Step 6: Select the following Sort/Total.

Step 7: Save the report by selecting Add
(F12).

Step 8: Run the Report by selecting Run
Report (F10).
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For assistance with report modification or information on
how to rate and book your products,
call 800.767.0080.
To view a detailed list of integrated providers, please visit:
http://www.reyrey.com/rpp.
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